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Using the DORIIS Portal: Self Service Distributor and Beverage 
Manufacturer Reports 

External Participant User Manual 

 

Objective 1A: Reporting: Monthly and Annual Distributor 
Reporting and Payment of CRV 

 
Procedure 
 
 
 

  

 

Step Action 

1.   Enter User Name and Password.  
 
Click the OK button. 
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Step Action 

2.   Select your Self Service Distributor responsibility. 
 
Navigate to: Create New Distributor Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 

Beverage Manufacturer Reports 
 

 

 Page 3 

  

 

Step Action 

3.   The Self Service Distributor window will appear.  
 
Click on the Reporting Year dropdown button to select from a list of 
values. 
 
Select the reporting year.  
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Step Action 

4.   Click on the From First Day Of dropdown button to select from a list 
of values. 
 
Select the month.  
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Step Action 

5.   Click on the To Last Day Of dropdown button to select from a list of 
values. 
 
Select the month.  
 
Special Note: The same month must be selected for both fields 
unless the account is approved for annual reporting.  
 
Only an account approved for annual reporting can be 
submitted for more than one month at a time (up to 12 months 
within the same calendar year).  

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 
Beverage Manufacturer Reports 

 

 

 

 Page 6 

  

 

Step Action 

6.   To Report Containers  Under 24 Ounces: 
 
Click on the Container Type dropdown button to select the material 
type for Under 24 Ounces Containers. 
 
Select the material type.  
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Step Action 

7.   Click in the Container Count (A) field to report the number of 
containers.  
 
Enter the container count.  

8.   To report additional material types, click the Add Under 24 Oz 
Containers Row button. 
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Step Action 

9.   A new row will appear.  
 
Click on the Container Type dropdown button to select the material 
type for Under 24 Ounces Containers. 
 
Special Note: Select a material type that is different from the 
previous ones selected.  
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Step Action 

10.   Click in the Container Count (A) field to report the number of 
containers.  
 
Enter the container count.  
 
Special Note: To enter additional container types, click the Add 
Under 24 Oz Container Row button and repeat this process as 
necessary for all material types to be reported. 
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Step Action 

11.   To Report Containers 24 Ounces and Larger: 
 
Click on the Container Type dropdown button to select the material 
type for 24 Ounces and Larger Containers. 
 
Select the material type. 
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Step Action 

12.   Click in the Container Count (A) field to report the number of 
containers.  
 
Enter the container count.  
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Step Action 

13.   To report additional material types, click the Add 24 Oz and Larger 
Containers Row button. 
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Step Action 

14.   A new row will appear.  
 
Click on the Container Type dropdown button to select the material 
type for 24 Ounces and Larger Containers. 
 
Select the material type. 
 
Special Note: Select a material type that is different from the 
previous ones selected. 
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Step Action 

15.   Click in the Container Count (A) field.  
 
Enter the container count.  
 
Special Note: To enter additional container types, click the 
Add 24 Oz and Larger Containers Row button and repeat this 
process as necessary for all material types to be reported. 
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Step Action 

16.   Click the Calculate button to calculate the CRV. 

 

17.   Check the I Agree box indicating you agree with the terms and 
conditions listed. 
 
Special Note: This is a required field. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 
Beverage Manufacturer Reports 

 

 

 

 Page 16 

  

 

Step Action 

18.   Click the Submit button to submit the report. 
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Step Action 

19.   The Distributor Report Confirmation window will appear. 
 
Review the information. 
 
If the report information is not correct, click on the Edit Report 
button and repeat the previous steps. 
 
Click the Continue Submission button if the information is correct. 
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Step Action 

20.   The Distributor Report Confirmation window will appear. 
 
Click the Printable Page button to print the report for your records. 
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Step Action 

21.   The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

22.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

23.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 
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Step Action 

24.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

25.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Distributor responsibility. 

 

26.   Click the Logout link to logout of the system. 

 

27.   End of Procedure. 
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Objective 1B: Reporting: Nothing to Report (Distributor) 

 
Procedure 
 
 
 
  

  

 

Step Action 

1.   Enter User Name and Password.  
 
Click the OK button.  
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Step Action 

2.   Select your Self Service Distributor responsibility. 
 
Navigate to: Create New Distributor Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 
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Step Action 

3.   The Self Service Distributor window will appear.  
 
Click on the Reporting Year dropdown button to select from a list of 
values. 
 
Select the reporting year. 
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Step Action 

4.   Click on the From First Day Of dropdown button to select from a list 
of values. 
 
Select the month. 
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Step Action 

5.   Click on the To Last Day Of dropdown button to select from a list of 
values.  
 
Select the month.  
 
Special Note: The same month must be selected for both fields 
unless the account is approved for annual reporting. 
 
Only an account approved for annual reporting can be 
submitted for more than one month at a time (up to 12 months 
within the same calendar year).  
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Step Action 

6.   Check the Nothing to Report box. 
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Step Action 

7.   Check the I Agree box indicating you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

8.   Click the Submit button to submit the report. 
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Step Action 

9.   The Distributor Report Confirmation window will appear.  
 
Review the information. 
 
If the report information is not correct, click on the Edit Report 
button and repeat the previous steps. 
 
Click the Continue Submission button if the information is correct. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 
Beverage Manufacturer Reports 

 

 

 

 Page 32 

  

 

Step Action 

10.   The Distributor Report Confirmation window will appear. 
 
Click the Printable Page button to print the report for your records. 
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Step Action 

11.   The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

12.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

13.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable Page 
button. 
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Step Action 

14.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

15.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Distributor responsibility. 
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Step Action 

16.   Click the Logout link to logout of the system. 

 

17.   End of Procedure. 
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Objective 2A: Amending Reports: Distributor Report 

 
Procedure 
 
 
  

  

 

Step Action 

1.   Enter User Name and Password. 
 
Click the OK button.  
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Step Action 

2.   Select your Self Service Distributor responsibility. 
 
Navigate to: Amend Prior Distributor Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 
Beverage Manufacturer Reports 

 

 

 

 Page 40 

  

 

Step Action 

3.   The Search Distributor Report Transactions window will appear.  
 
Select the transaction number you wish to amend in the 
Transaction Number column.  
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Step Action 

4.   The Self Service Distributor window will appear and the selected 
report will be displayed. 
 
If you are changing the container count in the original submission, 
enter the revised container count in the New Container Count (A) 
field.  
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Step Action 

5.   If you are adding container types under 24 ounces to the original 
submission, click on the Add Under 24 Oz Containers Row button.  
 
A new row will appear.  
 
Click on the Container Type dropdown button to select the material 
type from the list of values. 
 
Special Note: Select a material type that is different from the 
previous ones selected.  
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Step Action 

6.   Enter the container count in the New Container Count (A) field.  
 
Repeat this process as necessary for each new material type to be 
added to the report. 
 
Special Note: Repeat this process for any material types being 
amended for containers that are 24 ounces and larger. 
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Step Action 

7.   Click the Calculate button to calculate the CRV. 

 

8.   Check the I Agree box to indicate that you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

9.   Click the Submit button to submit the report. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 
Beverage Manufacturer Reports 

 

 

 

 Page 46 

  

 

Step Action 

10.   The Distributor Report Confirmation window will appear.  
 
Review the information. 
 
If the report information is not correct, click on the Edit Report 
button and repeat the previous steps. 
 
Click the Continue Submission button if the information is correct. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 

Beverage Manufacturer Reports 
 

 

 Page 47 

  

 

Step Action 

11.   The Distributor Report Confirmation window will appear. 
 
Click the Printable Page button to print a report for your records. 
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Step Action 

12.   The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

13.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

14.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 
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Step Action 

15.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

16.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Distributor responsibility. 
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Step Action 

17.   Click the Logout link to logout of the system. 

 

18.   End of Procedure. 

 
 

 

 

 

 

 

 

Objective 2B: Amending Reports: Correcting Nothing to Report to Reporting 
(Distributor) 
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Objective 2B: Amending Reports: Correcting Nothing to Report 
to Reporting (Distributor) 

 
Procedure 
 
 
 
  

  

 

Step Action 

1.   Enter User Name and Password. 
 
Click the OK button. 
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Step Action 

2.   Select your Self Service Distributor responsibility. 
 
Navigate to: Amend Prior Distributor Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 
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Step Action 

3.   The Search Distributor Report Transactions window will appear.  
 
Select the transaction number you wish to amend in the 
Transaction Number column.  
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Step Action 

4.   The Self Service Distributor window will appear.  
 
Uncheck the Nothing to Report box. 
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Step Action 

5.   Click on the Container Type dropdown button to select a material 
type from the list of values for containers under 24 ounces. 
 
Select a material type. 
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Step Action 

6.   Enter the container count in the New Container Count (A) field.  
 
To add additional material types for containers under 24 ounces, 
click the Add Under 24 Oz Containers Rows button. 
 
Another row will appear. 
 
Repeat the steps for any additional materials types added. 
 
Repeat this procedure for any containers 24 ounces and larger by 
selecting the material type from the Container Type field under the 
24 Ounces and Larger Containers header. 
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Step Action 

7.   Click the Calculate button to calculate the CRV. 

 

8.   Check the I Agree box to indicate you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

9.   Click the Submit button to submit the report. 
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Step Action 

10.   The Distributor Report Review window will appear.  
 
Review the information. 
 
If the information is not correct, click the Edit Report button and 
repeat the previous steps. 
 
Click the Continue Submission button if the information is correct. 
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Step Action 

11.   The Distributor Report Confirmation window will appear. 
 
Click the Printable Page button to print the report for your records. 
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Step Action 

12.   The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

13.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

14.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 
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Step Action 

15.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

16.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Distributor responsibility. 
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Step Action 

17.   Click the Logout link to logout of the system. 

 

18.   End of Procedure. 
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Objective 3A: Reporting: Monthly and Annual Manufacturer 
Reporting and Payment of Processing Fees 

 
Procedure 
 

  

 

Step Action 

1.   Enter User Name and Password.  
 
Click the OK button. 
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Step Action 

2.   Select your Self Service Beverage Manufacturer responsibility. 
 
Navigate to: Create New Beverage Manufacturer Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 
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Step Action 

3.   The Self Service Beverage Manufacturer window will appear.  
 
Click on the Reporting Year dropdown button to select from a list of 
values. 
 
Select the reporting year.   
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Step Action 

4.   Click on the From First Day Of dropdown button to select from a list 
of values.  
 
Select the month.  
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Step Action 

5.   Click on the To Last Day Of dropdown button to select from a list of 
values. 
 
Select the month.  
 
Special Note: The same month must be selected for both fields 
unless the account is approved for annual reporting.  
 
Only an account approved for annual reporting can be 
submitted for more than one month at a time (up to 12 months 
within the same calendar year).  
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Step Action 

6.  Click in the Refillable Glass Container Sold or Transferred 
Count field. 
 
Enter refillable container information. 
 
Enter refillable information for remaining three fields for refillable 
containers sold or transferred and refillable containers returned. 
 
Special Note: If your company did not sell or transfer any 
refillables, or have refillable containers returned during the 
reporting month, enter zero for these items. 

7.   Click on the Container Type dropdown button to select the material 
type from a list of values. 
 
Select the material type. 
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Step Action 

8.   Click in the Container Count (A) field.  
 
Enter the container count for the selected material type.  
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Step Action 

9.   Click the Add Another Row button to report additional material 
types. 
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Step Action 

10.   A new row will appear.  
 
Click on the Container Type dropdown button to select the material 
type from a list of values. 
 
Special Note: Select a material type that is different from the 
previous ones selected. 
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Step Action 

11.   Click in the Container Count (A) field.  
 
Enter the container count for the selected material type. 
 
Special Note: Repeat this process as necessary for all material 
types being reported.  
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Step Action 

12.   Click the Calculate button to calculate the Processing Fee. 

 

13.   Check the I Agree box to indicate you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

14.   Click the Submit button to submit the report. 
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Step Action 

15.   The Manufacturer Report Confirmation window will appear.  
 
Review the information. 
 
If the report is not correct, click on the Edit Report button and 
repeat the previous steps. 
 
Click the Continue Submission button. 
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Step Action 

16.   The Manufacturer Report Confirmation window will appear. 
 
Click the Printable Page button to print the report for your records. 
 
Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

17.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 

Beverage Manufacturer Reports 
 

 

 Page 83 

  

 

Step Action 

18.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

19.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Beverage Manufacturer responsibility. 
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Step Action 

20.   Click the Logout link to logout of the system. 

 

21.   End of Procedure. 
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Objective 3B: Reporting: Nothing to Report (Beverage 
Manufacturer) 

 
Procedure 
 

  

 

Step Action 

1.   Enter User Name and Password.  
 
Click the OK button. 
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Step Action 

2.   Select your Self Service Beverage Manufacturer responsibility. 
 
Navigate to: Create New Beverage Manufacturer Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 
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Step Action 

3.   The Self Service Beverage Manufacturer window will appear.  
 
Click on the Reporting Year dropdown button to select from a list of 
values. 
 
Select the reporting year. 
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Step Action 

4.   Click on the From First Day Of dropdown button to select from a list 
of values. 
 
Select the month. 
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Step Action 

5.   Click on the To Last Day Of dropdown button to select from a list of 
values. 
 
Select the month.  
 
Special Note: The same month must be selected for both fields 
unless the account if approved for annual reporting. 
 
Only an account approved for annual reporting can be 
submitted for more than one month at a time (up to 12 months 
within the same calendar year). 
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Step Action 

6.   Check the Nothing to Report box. 

 

7.  Click in the Refillable Glass Container Sold or Transferred 
Count field. 
 
Enter refillable container information. 
 
Enter refillable information for remaining three fields for refillable 
containers sold or transferred and refillable containers returned. 
 
Special Note: If your company did not sell or transfer any 
refillables, or have refillable containers returned during the 
reporting month, enter zero for these items. 
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Step Action 

8.   Check the I Agree box to indicate you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

9.   Click the Submit button to submit the report. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 

Beverage Manufacturer Reports 
 

 

 Page 93 

  

 

Step Action 

10.   The Manufacturer Report Confirmation window will appear.  
 
Review the information. 
 
If the report is not correct, click the Edit Report button and repeat 
the previous steps. 
 
Click the Continue Submission button. 
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Step Action 

11.   The Manufacturer Report Confirmation window will appear. 
 
Click the Printable Page button to print a report for your records. 
 
The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

12.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

13.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 
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Step Action 

14.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

15.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Beverage Manufacturer responsibility. 
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Step Action 

16.   Click the Logout link to logout of the system. 

 

17.   End of Procedure. 
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Objective 4A: Amending Reports: Beverage Manufacturer Report 

 
Procedure 
 

  

 

Step Action 

1.   Enter User Name and Password. 
 
Click the OK button.  
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Step Action 

2.   Select your Self Service Beverage Manufacturer responsibility. 
 
Navigate to: Amend Prior Beverage Manufacturer Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 
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Step Action 

3.   The Search Manufacturer Report Transactions window will appear.  
 
Select the transaction number you wish to amend from the 
Transaction Number column.  
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Step Action 

4.   The Self Beverage Manufacturer window will appear and the 
selected report will be displayed. 
 
If you are changing the original submission, enter the revised 
container count in the Container Count (A) field.  
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Step Action 

5.   If you are adding containers to the original submission, click on the 
Add Another Row button.  
 
A new row will appear.  
 
Click on the Container Type dropdown button to select a material 
type from the list of values. 
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Step Action 

6.   Enter the container count in the Container Count (A) field.  
 
Repeat this process as necessary for all material types that are 
being added to the report. 
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Step Action 

7.   Click the Calculate button to calculate the Processing Fee. 

 

8.   Check the I Agree box to indicate you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

9.   Click the Submit button to submit the report. 
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Step Action 

10.   The Manufacturer Report Confirmation window will appear.  
 
Review the information. 
 
If the report is not correct, click the Edit Report button and repeat 
the previous steps. 
 
Click the Continue Submission button if the information is correct. 
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Step Action 

11.   The Manufacturer Report Confirmation window will appear. 
 
Click the Printable Page button to print the report for your records. 
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Step Action 

12.   The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

13.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

14.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 
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Step Action 

15.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

16.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Beverage Manufacturer responsibility. 
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Step Action 

17.   Click the Logout link to logout of the system. 

 

18.   End of Procedure. 
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Objective 4B: Amending Reports: Correcting Nothing to Report 
to Reporting (Beverage Manufacturer) 

 
Procedure 
 

  

 

Step Action 

1.   Enter User Name and Password. 
 
Click the OK button. 
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Step Action 

2.   Select your Self Service Beverage Manufacturer responsibility. 
 
Navigate to: Amend Prior Beverage Manufacturer Report 
 
Special Note: The first time you login to DORIIS you may need 
to disable your popup blocker. 
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Step Action 

3.   The Search Manufacturer Report Transactions window will appear.  
 
Select the transaction number you wish to amend from the 
Transaction Number column.  
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Step Action 

4.   The Self Service Beverage Manufacturer window will appear.  
 
Uncheck the Nothing to Report box. 
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Step Action 

5.   Click the Add Another Row button. 
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Step Action 

6.   A new row will appear.  
 
Click on the Container Type dropdown button to select the material 
type from a list of values. 
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Step Action 

7.   Enter the container count in the Container Count (A) field.  
 
Repeat this process for all material types that will be reported. 
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Step Action 

8.   Click the Calculate button to calculate the Processing Fee. 

 

9.   Check the I Agree box to indicate you agree with the terms and 
conditions. 
 
Special Note: This is a required field. 
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Step Action 

10.   Click the Submit button to submit the report. 
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Step Action 

11.   The Manufacturer Report Confirmation window will appear.  
 
Review the information. 
 
If the report is not correct, click the Edit Report button and repeat 
the previous steps. 
 
Click the Continue Submission button if the information is correct. 
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Step Action 

12.   The Manufacturer Report Confirmation window will appear. 
 
Click the Printable Page button to print the report for your records. 
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Step Action 

13.   The confirmation will appear in a new browser. 
 
In the Menu bar, click on File and select Print. 
 
When printing is complete, click on the X button in the top right 
corner of the active window. 
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Step Action 

14.   Click on the Logout link to logout of the system or to create a 
Payment Voucher, click on the Create Payment Voucher button. 
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Step Action 

15.   The Account Payment Voucher window will appear. 
 
To print the Account Payment Voucher, click on the Printable 
Page button. 
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Step Action 

16.   The Account Payment Voucher will appear in a new browser.   
 
In the Menu bar, click on File and select Print. 

 

17.   When printing is complete, click on the X button in the top right 
corner of the active window. 
 
Special Note:  Payment Vouchers can also be printed from the 
Home page by navigating to: Print Payment Voucher under the 
Self Service Beverage Manufacturer responsibility. 
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Step Action 

18.   Click the Logout link to logout of the system. 

 

19.   End of Procedure. 
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Objective 5: Viewing Portal Reports 

 
Procedure 
 

  

 

Step Action 

1.   Enter User Name and Password. 
 
Click the OK button. 
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Step Action 

2.   The reports are available by clicking on the Tabs at the top of the 
Home page. 
 
To View the My Beverage Manufacturer Reports: 
 
Click the My Beverage Manufacturer Reports tab. 
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Step Action 

3.   The My Beverage Manufacturer Reports tab will open. 
 
The report will be displayed on this page. 
 
Special Note:  In this view, a maximum of 12 rows are 
displayed. 
 
To view additional rows of data, export report data, print the report, 
or to analyze data, click the Analyze link. 
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Step Action 

4.   The My Beverage Manufacturer Report Portal- Beverage 
Manufacturer Reports window will appear in the Discoverer Viewer. 
 
Under the Table header, there are Tools listed to assist in analyzing 
the data. 
 
To format the layout of the report, click the Layout link. 
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Step Action 

5.   Click on the first dropdown button in the Layout menu to move or 
swap fields in the report. 
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Step Action 

6.   Click on the second dropdown button in the Layout menu to select 
the field to move or swap in the report layout. 
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Step Action 

7.   Click on the third dropdown button in the Layout menu to select the 
placement of the field being moved or swapped. 
 
Click the Go button to change the layout of the report based on the 
options selected. 
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Step Action 

8.   To change the format of the report, click the Format link. 
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Step Action 

9.   In the Menu bar, click on the formatting options you want to appear 
in the report. 
 
To create a format for the cells in the report, click the Create 
Conditional Format link. 
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Step Action 

10.   The Create Conditional Cell Format window will appear. 
 
Click on the dropdown buttons under the Selections and Format 
headers to select a format for the report cells. 
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Step Action 

11.   Click the Apply button to apply any formatting changes selected. 
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Step Action 

12.   The My Beverage Manufacturer Report Portal- Beverage 
Manufacturer Reports window will reappear. 
 
Click the Stoplight link to format the report based on the values in 
the report. 
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Step Action 

13.   Click the Format dropdown button to select from a list of values. 

 

14.   Select the data points that will be included in the formatting from the 
Format list of values. 
 
Click in the Unacceptable field to enter the threshold for 
unacceptable values in the report. 

 

15.   Click in the Desirable field to enter the threshold for desirable 
values in the report. 
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Step Action 

16.   Click the Go button to apply the formatting selected. 
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Step Action 

17.   The report will display the selected formatting. 
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Step Action 

18.   The My Beverage Manufacturer Report Portal- Beverage 
Manufacturer Reports window will appear. 
 
To sort the data in the report, click the Sort link. 
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Step Action 

19.   Options for sorting the data will appear. 
 
Click on the Sort dropdown button. 
 
Select which field to sort the data by from the list of values in the 
Sort field. 

 

20.   Click the Order dropdown button to select how to order the data. 

 

21.   Click the Go button to apply the sorting options. 
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Step Action 

22.   Click the Rows and Columns link to select the number of rows and 
columns to view in the report. 
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Step Action 

23.   Click in the Rows field to enter the number of rows you want to 
include in the report. 
 
Click in the Columns field to enter the number of columns you want 
to include in the report. 
 
Click the Go button to apply the changes to the report. 
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Step Action 

24.   To export data, click the Export link in the Actions menu on the left 
side of the screen. 
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Step Action 

25.   The Choose export type window will appear. 
 
Click on the Choose Export Type dropdown button to select the 
export type from a list of values. 
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Step Action 

26.   Select the export type from the list of values in the Choose Export 
Type field. 

 

27.   Click the Export button. 

 

 
  



User Manual 
Using the DORIIS Portal: Self Service Distributor and 
Beverage Manufacturer Reports 

 

 

 

 Page 152 

  

 

Step Action 

28.   The Export Ready window will appear. 
 
Click the Click to view or save button to view or save the report. 
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Step Action 

29.   A new browser will open. 
 
A File Download box will appear asking you if you want to open or 
save this file.   
 
To view the report click the Open button or to save the report, click 
the Save button. 
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Step Action 

30.   A Security Warning window may appear.  
 
Click the Enable Macros button. 
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Step Action 

31.   The report will open in the browser. 
 
To print the report, in the Menu bar, click on File and select Print. 

 

32.   Click the X button in the top right corner of the active window to exit 
the report. 
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Step Action 

33.   A dialog box will appear asking if you want to save changes. 
 
Click No button to continue exiting the report or click the Yes button 
to save the report. 
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Step Action 

34.   The Export Ready window will appear. 
 
Click the Return to worksheet link to return to the My Beverage 
Manufacturer Report Portal- Beverage Manufacturer Report. 
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Step Action 

35.   To print the report from this view, click on the Printable page link in 
the Actions window. 
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Step Action 

36.   The Printable Page Options window will appear. 
 
Select printing options by clicking the button next to the options you 
want to select. 
 
To preview the report, click the Preview sample button. 
 
To print the report in a PDF format, click the Printable PDF button. 
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Step Action 

37.   The PDF Ready window will appear. 
 
Click the Click to view or save to view and print the report or to 
save the report. 
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Step Action 

38.   To return to the My Beverage Manufacturer Report Portal- My 
Beverage Manufacturer Report window, click the Return to 
worksheet link. 
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Step Action 

39.   To return to the portal, click the Cancel and return to Portal link. 
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Step Action 

40.   Click the Home link to return to the Home page or click the Logout 
link to logout of the system. 
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Step Action 

41.   To View the My Distributor Reports: 
 
Click the My Distributor Reports link. 

 

42.   The My Distributor Reports tab will open. 
 
Follow the steps listed in the previous section on viewing the My 
Beverage Manufacturer Reports to export, print, or analyze the data 
listed in the Distributor Report. 
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Step Action 

43.   To View My Payments: 
 
Click the My Payments link. 

 

44.   The My Payment History tab will open. 
 
Follow the steps listed in the previous section on viewing the My 
Beverage Manufacturer Reports to export, print, or analyze the data 
listed in the Payment History Report. 
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Step Action 

45.   To View Account History: 
 
Click the Account History link. 
 
The Account History tab will open. 
 
Follow the steps listed in the previous section on viewing the My 
Beverage Manufacturer Reports to export, print, or analyze the data 
listed in the Payment History Report. 
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Step Action 

46.   To View the Online Statement: 
 
Click the Online Statement link. 

 

47.   The Online Statement tab will open. 
 
Follow the steps listed in the previous section on viewing the My 
Beverage Manufacturer Reports to export, print, or analyze the data 
listed in the Payment History Report. 
 
Click the Home tab to return to the Home Page. 
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Step Action 

48.   Click the Logout link to logout of the system. 

 

49.   End of Procedure. 

 


